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Simulink® Control Design™ Release Notes

Summary by Version

This table provides quick access to what’s new in each version. For
clarification, see “Using Release Notes” on page 2.

Version (Release) New Features and | Version Fixed Bugs and
Changes Compatibility Known Problems
Considerations
Latest Version Yes No Bug Reports
V3.5 (R2012a) Details Includes fixes
V.3.4 (R2011b) Yes Yes Bug Reports
Details Summary Includes fixes
V3.3 (R2011a) Yes No Bug Reports
Details Includes fixes
V3.2 (R2010b) Yes No Bug Reports
Details Includes fixes
V3.1 (R2010a) Yes Yes Bug Reports
Details Summary Includes fixes
V3.0 (R2009Db) Yes No Bug Reports
Details Includes fixes
V2.5 (R2009a) Yes No Bug Reports
Details Includes fixes
V2.4 (R2008b) Yes No Bug Reports
Details Includes fixes
V2.3 (R2008a) Yes No Bug Reports
Details Includes fixes
V2.2 (R2007b) Yes No Bug Reports
Details Includes fixes
V2.1 (R2007a) Yes No Bug Reports
Details Includes fixes
V2.0.1 (R2006b) Yes No Bug Reports
Details Includes fixes
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Version (Release) New Features and | Version Fixed Bugs and

Changes Compatibility Known Problems
Considerations

V2.0 (R20064a) Yes No Bug Reports
Details Includes fixes

V1.3 (R14SP3) Yes No Bug Reports
Details Includes fixes

V1.2 (R14SP2) Yes No Bug Reports
Details Includes fixes

V1.1 (R14SP1) No No Fixed bugs

V1.0 R14) Yes No No bug fixes
Details

Using Release Notes
Use release notes when upgrading to a newer version to learn about:

e New features

¢ Changes

¢ Potential impact on your existing files and practices

Review the release notes for other MathWorks® products required for this
product (for example, MATLAB® or Simulink®). Determine if enhancements,
bugs, or compatibility considerations in other products impact you.

If you are upgrading from a software version other than the most recent one,
review the current release notes and all interim versions. For example, when
you upgrade from V1.0 to V1.2, review the release notes for V1.1 and V1.2.

What Is in the Release Notes

New Features and Changes

e New functionality
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Summary by Version

® Changes to existing functionality
Version Compatibility Considerations

When a new feature or change introduces a reported incompatibility between
versions, the Compatibility Considerations subsection explains the
impact.

Compatibility issues reported after the product release appear under Bug
Reports at the MathWorks Web site. Bug fixes can sometimes result

in incompatibilities, so review the fixed bugs in Bug Reports for any
compatibility impact.

Fixed Bugs and Known Problems

MathWorks offers a user-searchable Bug Reports database so you can view
Bug Reports. The development team updates this database at release time
and as more information becomes available. Bug Reports include provisions
for any known workarounds or file replacements. Information is available
for bugs existing in or fixed in Release 14SP2 or later. Information is not
available for all bugs in earlier releases.

Access Bug Reports using your MathWorks Account.

Documentation on the MathWorks Web Site

Related documentation is available on mathworks.com for the latest release
and for previous releases:

e Latest product documentation

e Archived documentation
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Version 3.5 (R2012a) Simulink Control Design Software

This table summarizes what’s new in Version 3.5 (R2012a):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes No Bug Reports

Details below

Includes fixes

New features and changes introduced in this version are:

® “Create Linearization Input/Output Sets in the Linear Analysis Tool ”
on page 4

e “Specify Feedback Sign for getLoopTransfer Without Specifying Loop
Openings” on page 4

Create Linearization Input/Output Sets in the Linear
Analysis Tool

You can now interactively create I/0 sets for linearization or frequency
response estimation in the Linear Analysis Tool, without adding linearization
points to your model. Previously, you had to modify your model to
interactively create I/0O sets.

For more information, see “Create Linearization I/O Sets In Linear Analysis
Tool”.

For more information about using the Linear Analysis Tool, see “Linearize at
Model Operating Point” and “Estimating Frequency Response”.

Specify Feedback Sign for getLoopTransfer Without
Specifying Loop Openings
An additional syntax for slTunable.getLoopTransfer allows you to specify

the feedback sign without having to provide an openings argument. Use
the syntax
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L = getLoopTransfer(ST,location,sign)

to calculate the point-to-point open-loop transfer function at location of the
Simulink model described by the s1Tunable interface ST. The software uses
the sign convention specified by sign (+1 or 1) to compute L.

Previously, to specify a feedback sign, you had to use the syntax

L = getLoopTransfer(ST,location,openings,sign)

This syntax required you to specify an openings argument to specify sign.
The new syntax allows you to specify sign while using the default loop
openings.

For more information, see the s1Tunable and s1Tunable.getLoopTransfer
reference pages.
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Version 3.4 (R2011b) Simulink Control Design Software

This table summarizes what’s new in Version 3.4 (R2011b):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes Yes — details labeled Bug Reports

Details below

as Compatibility Includes fixes
Considerations below.
See also Summary.

New features and changes introduced in this version are:

“Redesigned Graphical Tool for Improved Linear Analysis Workflows” on
page 6

“Interactive Frequency Response Estimation and Validation of
Linearization Results” on page 7

“Optimization of Model Parameters to Meet Design Requirements Specified
by Model Verification Blocks” on page 7

“Automatic Tuning of PID Controller Blocks in a Referenced Model” on
page 8

“Control System Tuning for Simulink Models with looptune or hinfstruct
Using slTunable Interface” on page 8

“Change in Default Number of Samples in frest.Chirp” on page 8

Redesigned Graphical Tool for Improved Linear
Analysis Workflows

The new interactive Linear Analysis Tool streamlines workflows for linear
analysis tasks such as finding steady-state operating points (trimming) and
linearization.

To access the Linear Analysis Tool:

1 Open a Simulink model.
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2 In the Simulink model, select Tools > Control Design > Linear
Analysis.

For more information about using the Linear Analysis Tool for operating-point
and linearization workflows, see:

e “Steady-State Operating Points”

e “Linearization”

Interactive Frequency Response Estimation and
Validation of Linearization Results

The new interactive Linear Analysis Tool provides a graphical interface for
frequency response estimation.

To access the Linear Analysis Tool:

1 Open a Simulink model.

2 In the Simulink model, select Tools > Control Design > Linear
Analysis to launch the Linear Analysis tool.

3 Click the Frequency Response Estimation tab to begin an estimation task.

For more information about using the Linear Analysis Tool for frequency
response estimation, see “Frequency Response Estimation”.

Optimization of Model Parameters to Meet Design
Requirements Specified by Model Verification Blocks

If you have Simulink Design Optimization™ software, you can optimize
the Simulink model to meet frequency-domain requirements specified in
Model Verification blocks. For example, you can optimize the linear system
to meet Bode magnitude or gain and phase margin requirements. For
more information, see Design Optimization To Meet Frequency-Domain
Requirements (GUI).

You can also include time-domain requirements such as step response
characteristics for optimization. For more information, see Design
Optimization to Meet Time- and Frequency-Domain Requirements.
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Automatic Tuning of PID Controller Blocks in a
Referenced Model

You can now use the PID Tuner to tune a PID Controller block in a model
that is referenced in one or more open models. When you launch the PID
Tuner from a block within a model reference, the software prompts you to
select which of the open models is the top-level model for analysis and tuning.
Previously, the PID Tuner could only use the model containing the PID
Controller block as the top-level model.

For more information, see “Tuning a PID Controller Within a Model
Reference”.

Control System Tuning for Simulink Models with
looptune or hinfstruct Using slTunable Interface

If you have Robust Control Toolbox™ software, you can use tuning commands,
such as s1Tunable.looptune and hinfstruct, to tune control systems
modeled in Simulink. The s1Tunable object provides an interface between
your Simulink model and these commands.

Use s1lTunable to specify information about your control structure and
parametrization. slTunable also automates tasks such as linearizing the
Simulink model, parametrizing the tunable blocks of your system, and
applying tuned parameter values to the model. After you create and configure
an slTunable object for your control architecture, you can tune the control
system using s1Tunable.looptune or hinfstruct.

For more information, see “Tuning Fixed Control Architectures” in the Robust
Control Toolbox documentation.

Change in Default Number of Samples in frest.Chirp

The default number of samples (NumSamples) in a frest.Chirp input signal
for frequency response estimation is now given by the formula:

4r
Ts * min(FreqRange)
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Ts is the sampling time of the chirp signal. FregRange is the vector of signal
frequencies of the chirp signal.

This formula returns twice the value returned in previous releases.

For example, if you create a default chirp input signal with the command
input = frest.Chirp

the value of input.NumSamples is 10000, instead of the previous value of 5000.

For more information, see the frest.Chirp reference page.

Compatibility Considerations

If you have scripts that rely on the default NumSamples formula, modify your
scripts to account for the new value.
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Version 3.3 (R2011a) Simulink Control Design Software

This table summarizes what’s new in Version 3.3 (R2011a):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes No Bug Reports

Details below

Includes fixes

New features and changes introduced in this version are

® “Ability to Select Individual Bus Elements as Linearization Input and

Output Points” on page 10

“Enhanced LINLFT Command Optionally Returns Linearization of
Excluded Blocks” on page 11

“Access to Current Linearization of a Simulink Block for Specifying Custom
Linearization” on page 11

“Enhanced PID Controller Blocks Display Compensator Formula in Block
Dialog Box” on page 11

Ability to Select Individual Bus Elements as
Linearization Input and Output Points

Instead of selecting an entire bus, you can now select individual elements
of the bus signal as linearization inputs or outputs (I/Os). By selecting
individual bus elements, you can:

¢ Obtain the linearization only for the channels of interest.

¢ Specify multiple I/Os, possibly as different types, in the same bus.
Select individual bus elements as I/Os when you want to:

¢ Linearize a Simulink model using the GUI or programmatically.

® Visualize time- and frequency-domain response during simulation using

the Linear Analysis Plots blocks.
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e Verify frequency-domain characteristics using the Model Verification
blocks.

For more information, see “Select Individual Bus Elements as Linearization
Points” and the 1inio reference page.

Enhanced LINLFT Command Optionally Returns
Linearization of Excluded Blocks

A new optional output argument to 1inlft returns the linearization of blocks
you specify for exclusion from the linearized model.

For more information, see the 1inlft reference page.

Access to Current Linearization of a Simulink Block
for Specifying Custom Linearization

When you use a specification function to specify a custom linearization of a
Simulink block, you can now access the current linearization in your function.
The current linearization is stored in the new BlockLinearization field of
the BlockData structure. The software automatically creates the BlockData
structure and passes it to your block linearization specification function.

For more information and an example showing how to use the
BlockLinearization field of BlockData, see “Augmenting the Linearization
of a Block”.

Enhanced PID Controller Blocks Display Compensator
Formula in Block Dialog Box

The PID Controller and PID Controller (2DOF) blocks now display the current
compensator formula in the block dialog box. This display reflects the current
settings for controller type, controller form, and time domain.

11
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Version 3.2 (R2010b) Simulink Control Design Software

This table summarizes what’s new in Version 3.2 (R2010b):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes No Bug Reports

Details below

Includes fixes

New features and changes introduced in this version are

¢ “New Blocks for Plotting and Verifying Linear System Characteristics of
Simulink Models” on page 12

e “New Tools for Identifying Time-Varying Source Blocks for Frequency
Response Estimation” on page 14

¢ “Tuning Tools Update Workspace Variables That Define Parameters of
Tuned Blocks” on page 14

e “Enhanced PID Tuner Including New Response Plots” on page 15

¢ “New Demo Illustrating Control Design for a Plant That Has Parameter
Variations” on page 15

New Blocks for Plotting and Verifying Linear System
Characteristics of Simulink Models
This version of Simulink Control Design™ software provides new blocks for:

® “Plotting Linear System Characteristics of Simulink Models” on page 12.

* “‘Verifying Linear System Characteristics of Simulink Models” on page 13.

Plotting Linear System Characteristics of Simulink Models
Simulink Control Design software provides six new blocks in the

Linear Analysis Plots library. Use these blocks to plot the time- and
frequency-domain characteristics of a linear system computed from a
nonlinear Simulink model. The linear system is computed and plotted during
simulation at:
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® Simulation snapshot times. The default snapshot time is 0.
® Trigger-based simulation events.

You can also use these blocks to specify bounds on the linear system
characteristics, and view the bounds on the plot.

Because these blocks are same as the “Model Verification” blocks except for
the default settings of the bound parameters, you can optionally use the
blocks to verify that the bounds are satisfied during simulation.

For more information, see:

® “Visualize Bode Response of Simulink Model During Simulation”
® “Linear Analysis Plots” block reference pages

® Plotting Linear System Characteristics of a Chemical Reactor demo

Verifying Linear System Characteristics of Simulink Models
Simulink Control Design software provides six new blocks in the Model
Verification library. Use these blocks to verify that the time- and
frequency-domain characteristics of a linear system, computed from a
nonlinear Simulink model, satisfy specified bounds during simulation. For
example, you can verify whether the linearized behavior of your model
satisfies upper and lower magnitude bounds on a Bode plot or gain and phase
margins.

You can perform the verification during simulation at:

¢ Simulation snapshot times. The default snapshot time is 0.

* Trigger-based simulation events
Because these blocks are same as the “Linear Analysis Plots” blocks except for
the default settings of the bound parameters, you can use the blocks to view

the bounds on time- and frequency-domain plots.

You can also use these blocks with the Simulink Model Verification library
blocks to design complex logic for model verification.

13
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If you have Simulink Verification and Validation™ software, you can
construct simulation tests for your model using the Verification Manager.

For more information, see:

e “Model Verification” in the Simulink Control Design documentation.
* “Model Verification” block reference pages

e Verifying Frequency-Domain Characteristics of an Aircraft demo

New Tools for Identifying Time-Varying Source
Blocks for Frequency Response Estimation

When you are performing frequency response estimation, time-varying source
blocks in the signal path can skew the results. Previously, to obtain accurate
estimation, you manually identified source blocks and inserted open-loop
points in your model to disable them.

The new frest.findSources command automatically detects time-varying
source blocks in the signal path of the output linearization points in your
Simulink model. Additionally, a new option to the frestimate command,
BlocksToHoldConstant, allows you to disable these blocks during frequency
response estimation.

For more information, see the frest.findSources and frestimateOptions
reference pages.

There is also a new Model Advisor check for detecting time-varying source
blocks in your model. For more information about using the Model Advisor,
see Consulting the Model Advisor in the Simulink User’s Guide.

Tuning Tools Update Workspace Variables That
Define Parameters of Tuned Blocks

When you use Simulink Control Design tools to tune a block with parameters
defined as workspace variables, the software now updates the values of the
workspace variables. This update occurs when you write the compensator
design to your Simulink model. The block remains parametrized by the
variables. The software can update variable parameters that represent


http://www.mathworks.com/help/toolbox/slvnv/ug/f6010dfi2.html

Version 3.2 (R2010b) Simulink® Control Design™ Software

numerical values or Simulink.Parameter objects, whether they reside in the
base workspace or the model workspace.

Previously, tuning a block parametrized by workspace variables overwrote the
block parameters with numerical values. Thus, such tuning did not change
the value of the workspace variables.

Enhanced PID Tuner Including New Response Plots
This release introduces several enhancements to the PID Tuner, including:

e New response plot options let you analyze system responses in either time
domain (step plot) or frequency domain (Bode plot). Available responses
are reference tracking, input and output disturbance rejection, controller
effort, open loop, and plant.

®* New options when the plant linearizes to zero at the operating point
defined in the Simulink model.

When the plant linearizes to zero on launch of the PID Tuner, the PID
Tuner provides an option to linearize at a different operating point. The
PID Tuner also lets you import an LTI model of your plant, such as a model
obtained by frequency response estimation. Previously, the PID Tuner did
not launch when the plant linearized to zero.

For an example illustrating these options, see the new Simulink Control
Design demo, Designing PID Controller in Simulink with Estimated
Frequency Response.

For more information about using the PID Tuner, see “Automatic PID
Tuning” in the Simulink Control Design User’s Guide.

New Demo lllustrating Control Design for a Plant
That Has Parameter Variations

The Reference Tracking of a DC Motor with Parameter Variations demo
illustrates compensator design for a plant that has parameter variations. The
demo shows the following techniques:

¢ Performing batch linearization to obtain multiple linear models from a
single Simulink model

15
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® Using the new SISO Design Tool ability to analyze a control design for
multiple models simultaneously
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Version 3.1 (R2010a) Simulink Control Design Software

This table summarizes what’s new in Version 3.1 (R2010a):

New Features and Changes | Version Compatibility

Considerations

Fixed Bugs and Known
Problems

Yes
Details below

Yes — details labeled
as Compatibility
Considerations below.
See also Summary.

Bug Reports
Includes fixes

New features and changes introduced in this version are

¢ “New Parallel Computing Support For Frequency Response Estimation”

on page 17

¢ “New Commands Support Recomputing Frequency Response Estimation
Results at Specific Frequencies” on page 18

* “New frest.simcompare Output Argument Returns Simulation Output Data

From Linear System” on page 18

¢ “New Options in Simulink Results Viewer GUI for Viewing Frequency

Response Estimation Results” on page 18

¢ “New Option for Labeling Bus Signal I/O Names in the SISO Design Task”

on page 18

¢ “Existing Simulink Blocks Now Have Analytic Jacobians” on page 19

¢ “Change in Format of Time Series in frestimate Output” on page 19

New Parallel Computing Support For Frequency

Response Estimation

If you have the Parallel Computing Toolbox™ software installed, you can use
parallel computing to speed up frequency response estimation.

For more information, see “Speeding Up Estimation Using Parallel
Computing” in the Simulink Control Design documentation.

17
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New Commands Support Recomputing Frequency
Response Estimation Results at Specific Frequencies

If you use the sinestream input signal for estimation, you can now recompute
your frequency response estimation for only those specific frequencies that do
not reach steady state. Previously, you had to redo the entire estimation if a
few frequencies needed recomputing.

For more information, see “T'ime Response Not at Steady State”.

New frest.simcompare Output Argument Returns
Simulation Output Data From Linear System

This release provides enhanced frest.simCompare functionality, which
allows the return of simulated output data. If your linear model uses
state-space representation, you can also return the state vector.

For more information, see the frest.simCompare reference page.

New Options in Simulink Results Viewer GUI for
Viewing Frequency Response Estimation Results

The Simulation Results Viewer GUI, which you display using frest.simView,
now provides additional options for analyzing your frequency response
estimation:

® You can now enable phase unwrapping in the frequency response plot. To
unwrap phase, right-click the Bode plot, and select Unwrap Phase.

® You can also import frequency response estimation results into an open
Simulation Results Viewer, which replaces the existing results. Previously,
you had to open a new Viewer each time you viewed estimation results. To
import results, select File > Import in the Simulation Results Viewer.

New Option for Labeling Bus Signal 1/0 Names in
the SISO Design Task

You can now configure the SISO Design Task to automatically label model
I/0s using bus signal names. Model I/O labels describe available loops in the
Graphical Tuning tab and label response plots in the Analysis Plots tab of the
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SISO Design Task GUI. Previously, labels for bus signals were based on the
block and port path, or the Simulink signal name.

To use this option, select Tools > Options in the SISO Design Task GUI, and
enable Use bus signal names to label model I/0.

Existing Simulink Blocks Now Have Analytic
Jacobians

The following Simulink blocks now have Analytic Jacobians, which are
optimized for memory consumption in large-scale models:

® Switch
e Multiport Switch

¢ Math Function (Transpose and Hermitian Transpose)

For more information on each block, see the block reference pages.

Change in Format of Time Series in frestimate Output

When you use the simout output of the frestimate command, you obtain a
cell array of Simulink.Timeseries objects. Previously, the time dimension
was always the first dimension of each Simulink.Timeseries object.

As of R2010a, the time dimension of each Simulink.Timeseries in simout is:
e The first dimension, if the time series is 2-D

¢ The last dimension, if the time series is 3-D or higher

Compatibility Considerations

If you have scripts that run frestimate on a model having an output point
on a vector or matrix signal and perform operations on the resulting 3-D or
higher-dimensional Simulink.Timeseries object in simout, modify your
scripts to reflect the new placement of the time dimension in the time series.

For additional information, see:
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e MATLAB Data Analysis Release Notes
e frestimate reference page

® Simulink.Timeseries reference page


http://www.mathworks.com/access/helpdesk/help/techdoc/rn/bsdic8e-1.html
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Version 3.0 (R2009b) Simulink Control Design Software

This table summarizes what’s new in Version 3.0 (R2009b):

New Features and Changes | Version Compatibility

Considerations

Fixed Bugs and Known
Problems

Yes
Details below

No

Bug Reports
Includes fixes

New features and changes introduced in this version are

e “New GUI for Tuning New PID Controller Blocks” on page 21

® “New Automated PID Tuning Algorithm” on page 22

e “Ability to Compute Frequency Response of Simulink Models” on page 22

e “Ability to Specify the Linearization of Simulink Blocks” on page 22

e “Ability to Design Compensators for Plant Models With Time Delays” on

page 22

e “New Commands to More Efficiently Compute Multiple Linearizations”

on page 23

e “Ability to Set Default Plot Type for Linear Analysis Results from GUI”

on page 23

New GUI for Tuning New PID Controller Blocks

You can automatically tune the new Simulink PID Controller blocks in the
PID Tuner GUI R2009b introduces. You launch the PID Tuner directly from
the PID block dialogs boxes. These blocks are available in the Continuous and

Discrete Simulink libraries.

For more information on tuning PID Controller using the PID Tuner, see

“Automatic PID Tuning”.
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New Automated PID Tuning Algorithm

You can now tune compensators using a new automated PID tuning algorithm
called Robust Response Time, which is available in the SISO Design Task.
You specify the open-loop bandwidth and phase margin, and the software
computes PID parameters to robustly stabilize your system.

For information on tuning compensators using automated tuning methods,
see “Completing the Design”.

Ability to Compute Frequency Response of Simulink
Models

You can now compute the frequency response of a Simulink model using
simulation. You use new commands to easily create input signals and
simultaneously simulate and estimate the frequency response without
changing your model. You can also use this capability to validate the accuracy
of exact linearizations.

Ability to Specify the Linearization of Simulink Blocks

You can now specify the linearization of Simulink blocks, subsystems, and
model references without having to replace any block in your model. You can
specify the linearizations as LTI models or Robust Control Toolbox uncertain
models.

Ability to Design Compensators for Plant Models
With Time Delays
You can now design compensators for plants with exact time delay

representations. Previously, you had to specify a Padé approximation before
designing compensators.

For more information on designing compensators for plants with time delays,
see “Designing Compensators for Plants with Time Delays”.
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New Commands to More Efficiently Compute Multiple
Linearizations

You can now more efficiently compute multiple linearizations for large models
when only a few blocks or model references change per linearization. You
linearize the fixed portion of the model once using 1inlft and linearize

the varying portion multiple times. Then, you combine the results using
linlftfold to obtain linearizations equal to those you would receive if you
linearized the entire model multiple times.

For more information, see the 1inlft and 1inlftfold reference pages.

Ability to Set Default Plot Type for Linear Analysis
Results from GUI

You can now set the default plot type for viewing linear analysis results
computed in the Control and Estimation Tools Manager. This setting applies
to all future Control and Estimation Tools Manager sessions.

To set this option in the Simulink Control Design Preferences, select
File > Preferences in the Control and Estimation Tools Manager.
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Version 2.5 (R2009a) Simulink Control Design Software

This table summarizes what’s new in Version 2.5 (R2009a):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes No Bug Reports

Details below

Includes fixes

New features and changes introduced in this version are

e “Ability to Generate MATLAB Code from the GUI for Creating Operating
Points and Linearizing Models” on page 24

e “Ability to Tune Additional Blocks” on page 24

¢ “New Option for Labeling Bus Signal I/O Names in Linearization Results”

on page 25

Ability to Generate MATLAB Code from the GUI for
Creating Operating Points and Linearizing Models

You can now generate MATLAB code reflecting the configuration in the GUI
when creating operating points and linearizing models.

Ability to Tune Additional Blocks
You can now tune the following blocks:

¢ Blocks that you discretized using the Simulink Model Discretizer

¢ Blocks in the Simulink Extras library that specify initial states or outputs

For information about how to tune these blocks, see “Selecting Blocks to
Tune” in the Simulink Control Design documentation.


http://www.mathworks.com/support/bugreports/?product=SD&release=R2009a
http://www.mathworks.com/support/bugreports/?product=SD&release=R2009a
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New Option for Labeling Bus Signal 1/0 Names in
Linearization Results

You can now compute linear models that show the bus signal names for
linearization I/O points located on buses. You can select this option using
the following:

e Linearization Options GUI

e linoptions command
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Version 2.4 (R2008b) Simulink Control Design Software

This table summarizes what’s new in Version 2.4 (R2008b):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes No Bug Reports

Details below

Includes fixes

New features and changes introduced in this version are

¢ “New Upsampling Option for Rate Conversion When Linearizing Simulink
Models” on page 26

e “Ability to Specify State Order of Linearized Models from the Command
Line” on page 27

® “Ability to Filter the Linearization Inspector to Show Blocks in the
Linearization Path” on page 27

e “Ability to Disable the Calculation of Linearization Diagnostics and
Inspector Data in the GUI” on page 27

New Upsampling Option for Rate Conversion When
Linearizing Simulink Models

Version 2.4 includes an upsampling rate conversion method for linearization.
This method upsamples discrete-time LTI systems at any sampling rate that
is an integer-value-times faster than the sampling rate of the original system.
You can select the upsampling rate conversion method in the following ways:

¢ Using the linearization options GUI

® From the command line using linoptions

For more information on the upsampling rate conversion method, see the
linoptions reference page.


http://www.mathworks.com/support/bugreports/?product=SD&release=R2008b
http://www.mathworks.com/support/bugreports/?product=SD&release=R2008b

Version 2.4 (R2008b) Simulink® Control Design™ Software

Ability to Specify State Order of Linearized Models
from the Command Line

You can now specify the order of the states in your linearized model directly
from the command line using the linearize command. Previously, you could
only specify state order using the GUI.

For more information on specifying state order from the command line, see
the linearize reference page.

Ability to Filter the Linearization Inspector to Show
Blocks in the Linearization Path

You can now filter the list of blocks in the Linearization Inspector to show
only the blocks in the linearization path. This filtering makes it easier for you
to find blocks in the linearization path that you want to inspect.

Ability to Disable the Calculation of Linearization
Diagnostics and Inspector Data in the GUI

You can now disable the calculation of the linearization inspector and
diagnostics information when you linearize using the GUI. This capability
allow you to choose when you want to calculate diagnostic information.
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This table summarizes what’s new in Version 2.3 (R2008a):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems

Yes No Bug Reports

Details below Includes fixes

New features and changes introduced in this version are

”

e “New Diagnostic Messages Help You Troubleshoot Linearization Results
on page 28
e “Ability to Find Operating Points for Simscape Models” on page 28

e “Updated Error and Warning Message System” on page 29

New Diagnostic Messages Help You Troubleshoot
Linearization Results

You can now view diagnostic messages for your linearized model that help
you diagnose and troubleshoot linearization results. These messages identify
blocks in your model that encounter the following block issues during
linearization:

® Blocks that have been marked as not supported for linearization

¢ Blocks with linearization configuration warning messages

¢ Blocks without pre-programmed exact Jacobian that linearize using
numerical approximation

Ability to Find Operating Points for Simscape Models

You can now find operating points for models that include Simscape™ and
SimHydraulics® blocks using the Simulink Control Design findop command.

For more information on finding operating point for Simscape Models, see
the Simscape documentation.


http://www.mathworks.com/support/bugreports/?product=SD&release=R2008a
http://www.mathworks.com/support/bugreports/?product=SD&release=R2008a
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Updated Error and Warning Message System

The Simulink Control Design error and warning IDs and messages have been
updated. If you use error and warning IDs in your code, you must update your
code to reflect the new IDs.

29



Simulink® Control Design™ Release Notes

Version 2.2 (R2007b) Simulink Control Design Software

This table summarizes what’s new in Version 2.2 (R2007b):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems

Yes No Bug Reports

Details below Includes fixes

New features and changes introduced in this version are

e “Ability to Linearize Models with Model-Reference Blocks by Any
Linearization Method” on page 30

e “Ability to Design Compensators for Models Containing Model-Reference
Blocks” on page 30

® “Ability to Generate Linearized Models with Exact Time-Delay
Representations” on page 31

e “Ability to Linearize Periodic Function-Call Subsystems” on page 31

Ability to Linearize Models with Model-Reference
Blocks by Any Linearization Method

You can now perform any type of linearization for models containing Model
blocks that reference other Simulink models.

Previously, you could only perform numerical perturbation linearization for
models containing Model blocks. Now, you can also perform block-by-block
linearization for such models when you set the simulation mode of the Model
blocks to Normal.

Ability to Design Compensators for Models
Containing Model-Reference Blocks

You can now design compensators for tunable blocks inside external models
referenced by your model. Your model references such external models by


http://www.mathworks.com/support/bugreports/?product=SD&release=R2007b
http://www.mathworks.com/support/bugreports/?product=SD&release=R2007b
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using Model blocks. You can also update the tunable blocks in the external
model with the new compensator designs.

To view and select tunable blocks for compensator design from the referenced
model, set the simulation mode of the Model block to Normal.

For more information about the types of blocks that you can tune, see
“Selecting Blocks to Tune” in the Simulink Control Design documentation.

Ability to Generate Linearized Models with Exact
Time-Delay Representations

You can now use the Simulink Control Design software to compute linearized
models with exact time-delay representations. Time delays in the original
nonlinear model can result from any of the following blocks:

® Transport Delay

Variable Time Delay

Variable Transport Delay
Unit Delay

Integer Delay

Previously, you could only achieve approximate linearizations of models with
continuous time delays using a Padé approximation.

Ability to Linearize Periodic Function-Call Subsystems

You can now linearize periodic function-call subsystems with a constant
sample time as discrete subsystems. You must set the sample time of the
function-call trigger block to equal the sample time of the function-call
generator block.

For more information on function-call subsystems, see “Function-Call
Subsystems” in the Simulink documentation.
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Version 2.1 (R2007a) Simulink Control Design Software

This table summarizes what’s new in Version 2.1 (R2007a):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes No Bug Reports

Details below

Includes fixes

New features and changes introduced in this version are

® “Ability to Linearize Using an Operating Point Specified Directly in a
Model” on page 32

e “Ability to Capture Linearization Snapshots in GUI” on page 33

e “Ability to Perform Control Design at Snapshots in GUI” on page 33

® “Ability to Retrieve Stored Compensator Designs” on page 33

Ability to Linearize Using an Operating Point
Specified Directly in a Model

You can use the Simulink Control Design software to linearize around any
operating point that you specify directly in a Simulink model. This capability
allows you to make changes to a model and then perform a linearization
around the newly specified operating point with the click of a single button.
Previously, this same task required two steps: creating a new operating point
and then linearizing around this operating point.

There are two ways to linearize around an operating point specified directly
in the model:

¢ From the Control and Estimation Tools Manager

e Using linearize


http://www.mathworks.com/support/bugreports/?product=SD&release=R2007a
http://www.mathworks.com/support/bugreports/?product=SD&release=R2007a
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Ability to Capture Linearization Snapshots in GUI

You can use the Control and Estimation Tools Manager to linearize at
snapshots of your model operating point at the following simulation points:

® Specified simulation times, such as when the simulation reaches a steady
state solution

¢ Events during a specified simulation interval

As in prior releases, you can use linearize to perform linearization at
snapshots in your model operating point, as described in 1linearize in the
reference pages.

Ability to Perform Control Design at Snapshots in GUI

You can use the Control and Estimation Tools Manager to perform control
design at snapshots of your model operating point at the following simulation
points:

® Specified simulation times, such as when the simulation reaches a steady
state solution

¢ Events during a specified simulation interval

Ability to Retrieve Stored Compensator Designs

When you design a compensator using the SISO design tool, you can store
the current design and then continue making changes to this design. A new
button called Retrieve Design lets you retrieve the stored design at any time
by undoing the design changes you made since you last stored the design. For
more information on retrieving stored compensator designs, see “Storing and
Retrieving Designs” in the Simulink® Control Design™ documentation.
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Version 2.0.1 (R2006b) Simulink Control Design Software

This table summarizes what’s new in Version 2.0.1 (R2006b):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
No No Bug Reports
Includes fixes

34
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Version 2.0 (R2006a) Simulink Control Design Software

This table summarizes what’s new in Version 2.0 (R2006a):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
Yes No Bug Reports

Details below

Includes fixes

New features and changes introduced in this version are

Compensator Design in Simulink Is Now Supported

This release provides new tools to streamline the workflow for designing
Single-Input Single-Output (SISO) control loops directly in Simulink. In
previous releases, designing a compensator was a multistep process that
involved several tools.

The new tools support any linearizable control architecture, such as single
loops, multiple loops, and cascaded loops. With the new tools, you simply
select the blocks you want to tune. Then, the Simulink Control Design
software automatically analyzes your model to identify the relevant control
loops and opens a preconfigured session of the SISO Design Tool (in the
Control System Toolbox™ software). For more information, see “Designing
Compensators” in the Simulink Control Design documentation.

Supported tunable SISO Simulink blocks include Gain, Transfer Function,
Zero-Pole-Gain, State-Space, and PID blocks.

In the SISO Design Tool you can

® Graphically tune multiple SISO loops in a single GUIL.
¢ Gain visual insight into loop interactions and coupling effects.

® Focus the analysis on a specific loop in a multiloop design by removing
the effect of other feedback loops.
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® Generate first-cut compensator designs using systematic design algorithms,
such as Ziegler-Nichols PID tuning, IMC design, or LQG design.

e Optimize linear responses to meet time and frequency-based design
constraints (requires the Simulink Response Optimization™ software).

¢ Directly tune Simulink block parameters, such as PID gains, zero-pole-gain
representations, and masked blocks.

® Tune continuous or discrete control loops.
e Examine the closed-loop response of any portion of a model.

After a design is completed, you can write the tuned parameter values back to
your model for verification with the full nonlinear system.
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Version 1.3 (R14SP3) Simulink Control Design Software

This table summarizes what’s new in Version 1.3 (R14SP3):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems

Yes No Bug Reports

Details below Includes fixes

New features and changes introduced in this version are

® “Control and Estimation Tools Manager Enhanced” on page 37

® “Support for Operating Point Search and Linearization of Models with
Model Reference Blocks” on page 37

Control and Estimation Tools Manager Enhanced

You can copy and edit operating points within the Control and Estimation
Tools Manager. .

You can initialize a model for simulation using operating points from within
the Control and Estimation Tools Manager.

Support for Operating Point Search and Linearization
of Models with Model Reference Blocks

You can linearize and compute operating points for models that reference
other models using the Model block. Linearization of model reference models
must use the numerical perturbation linearization algorithm. This algorithm
accepts state and input perturbation values in the form of an operating point
object.
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Version 1.2 (R14SP2) Simulink Control Design Software

This table summarizes what’s new in Version 1.2 (R14SP2):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems

Yes No Bug Reports

Details below Includes fixes

New features and changes introduced in this version are

® “Context-Sensitive Help Added” on page 38

® “View Linearizations in the Control and Estimation Tools Manager” on
page 38

® “Discretization Methods Added” on page 39

e “List of Blocks with Preprogrammed Analytic Jacobians Added” on page 39

¢ “Block Name Readability Improved” on page 39

Context-Sensitive Help Added

Access context-sensitive help for the Linearization, Operating Point Search,
and Linearization State Ordering Options window of the Control and
Estimation Tools Manager. To access help on a field within the options
window, right-click the option’s label and select What’s this? from the
context menu. Help for the option will appear in this window.

View Linearizations in the Control and Estimation
Tools Manager

You can view state space, transfer function, and zero-pole gain representations
of linearized models within the Control and Estimation Tools Manager
without exporting to the workspace. These linearized models appear in the
linearization summary pane of the Control and Estimation Tools Manager.


http://www.mathworks.com/support/bugreports/?product=SD&release=R14SP2
http://www.mathworks.com/support/bugreports/?product=SD&release=R14SP2
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Discretization Methods Added

You can select from three different discretization methods for linearization of
multirate and hybrid models.

List of Blocks with Preprogrammed Analytic
Jacobians Added

You can view a complete list of blocks indicating which blocks have
preprogrammed analytic Jacobians for use with the block-by-block analytic
linearization algorithm.

Block Name Readability Improved

You can use either truncated block names or full block names in the state
space matrices of a linearized model, and within the LTI Viewer, to improve
readability.
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Version 1.1 (R14SP1) Simulink Control Design Software

This table summarizes what’s new in Version 1.1 (R14SP1):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems
No No Fixed Bugs
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Version 1.0 (R14) Simulink Control Design Software

This table summarizes what’s new in Version 1.0 (R14):

New Features and Changes | Version Compatibility Fixed Bugs and Known
Considerations Problems

Yes No No bug fixes

Details below

New features and changes introduced in this version are

About the Simulink Control Design Software

The Simulink Control Design software provides tools for the linearization
of control systems and models. A graphical user interface (GUI) simplifies
the tasks of specifying operating conditions, linearizing the model, and
analyzing the results. Linearized models often facilitate system analysis
and compensator design. This is useful in many industries and applications,
including

e Aerospace: flight control, guidance, navigation
® Automotive: cruise control, emissions control, transmission

¢ Equipment manufacturing: motors, disk drives, servos

The Simulink Control Design software improves upon previous Simulink
linearization tools by providing more options for computing operating
conditions, allowing open loop analysis without the removal of feedback loops,
and including a linearization inspector and debugger. Linearization projects
are easier to manage with the new Control and Estimation Tools Manager.
Furthermore, the Control System Toolbox software features, such as the LTI
Viewer, are integrated with the Control Designer software to improve control
system analysis and design.
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Key Features Introduced
Key features of the Simulink Control Design software include the ability to

® Specify linearization input, output, and open loop analysis points using
right-click menus

¢ Perform open loop analysis without deleting feedback loops

e Extract operating conditions from a simulation

* Compute operating conditions by optimization (trimming)

¢ (Create output constraints for trim analysis

¢ Linearize individual blocks using context menus

¢ Inspect and debug results of the linearization

¢ Identify blocks in a model that contribute to a linearization

e Export results to the MATLAB workspace

e Manage linearization projects, compute operating conditions, and perform
linearization with a graphical user interface (GUI)

¢ Use improved functions at the command line for linearization and trim
analysis
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Compatibility Summary for Simulink Control Design
Software

This table summarizes new features and changes that might cause
incompatibilities when you upgrade from an earlier version, or when you
use files on multiple versions. Details are provided in the description of the
new feature or change.

Version (Release) New Features and Changes with
Version Compatibility Impact

Latest Version None

V3.5 (R2012a)

V3.4 (R2011b) See the Compatibility

Considerations subheading
for this change:

¢ “Change in Default Number of
Samples in frest.Chirp” on page 8

V3.3 (R2011a) None
V3.2 (R2010b) None
V3.1 (R2010a) See the Compatibility

Considerations subheading
for this change:

¢ “Change in Format of Time Series
in frestimate Output” on page 19

V3.0 (R2009b) None
V2.5 (R2009a) None
V2.4 (R2008b) None
V2.3 (R2008a) None
V2.2 (R2007b) None
V2.1 (R2007a) None
V2.0.1 (R2006b) None
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Version (Release)

New Features and Changes with
Version Compatibility Impact

V2.0 (R2006a) None
V1.3 (R14SP3) None
V1.2 (R14SP2) None
V1.1 (R14SP1) None
V1.0 (R14) None
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